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ABSTRACT

This thesis presents the design of an Emergency Generator using Air Buoyancy
in Water. which the machine will consist of two parts: The control part of the supply
of air to the air cylinder and the part that produces electricity. The work control will
start working when the power is off. The microcontroller will order the air valve to
open the air supply to each cylinder. cause the rotation of Emergency Generator using
Air Buoyancy in Water. will cause the generator to spin as well. when connected to a
rectifier circuit to be direct current will be connected to the inverter circuit for use with
electrical appliances and the microcontroller releases air into each air cylinder. Until
the air pressure in the air tank is lower than 2 bar, the air supply will be stopped.

Experimental results of Emergency Generator using Air Buoyancy in Water
Supplying air into the air reservoir Make the machine spin to spin the generator with a
rotation speed of 0.069 meters per second. And the voltage through the rectifier will
have a DC voltage of 5.62 volts. But the inverter circuit requires a DC input voltage of
at least 11 volts. Therefore, the voltage from the generator cannot drive the inverter

circuit.
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colkd
Genuino

ARDUINO

AN OPEM PROJECT WRITTEN, DEBUCGED,

AND SUPPORTED BY ARDUIND.CC AND 0o IK‘\

THE ARDUINO COMMUNITY WORLDWIDE S 5 . ?l./
(8}

LEARN MORE ABOUT THE COMTRIBUTORS

oF [ECIIELIEA on arduino.ccicredits

ot ellof ol e+ ol oL

Starting...
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(RGB 0 i3 256) fllsldwsunmadudinglufitia annsademuaudadalnlfanlunsy iy

waadudvniinssuenwanafndeduldlddulusuniu duandugy 2.3

5UN 2.3 sUsveslugansivaeudvesing

v U

(Fian: https://www.arduitronics.com)



[ '
6 o ISy =

FUNTea 230 FegunsaldanenantaiunsaiaziufgunlasAininuadngesdinun

=] d

ﬂiwuéffsﬁﬂﬁaaﬂmL‘T;Jué’iy,fywmmm?iLmﬁwmamaau (Square wave) lagiA1AIIUNI
Wad(Duty - cycle) tWu 50 LU@%LG‘?}uﬁ?}qmmﬁ'Lmﬁwméﬁ’aﬂdn%ﬁwammé’mﬁuﬁmmﬂf“fUﬂ'ﬂ
maiwediiannssnuidues Tnslnsiasawesiiies 3200 tuazuszneullde
Tlalalonwunn 8x8 1 GefinsdniSesiuwuy o556 Tnelnlglalonmaniozudseaniu 4
nauseiu fe Tuldlalenfififlames Auns (Red) o7 (Green) 1nidu (Blue) wazuuulsid
awnes (Clear) S1uauvaay 16 f Fausaznauavmeuauswionuailsvediiuanseiuly
muusazeiavedvasilamodii 4

waszidnannsenuilnldlalen Fasansadensinfiawesvedllslalen ld
Mnudyana S2 waz s3 lnsnafildazogluguvesnszualufiuazavdsludaniaiudeu
nszuatduaud (Current-to-Frequency Converter) tiovntiiutaanszualniihlndu
é’ﬁgﬁgmmm5'aaﬂlﬂﬁmﬁ’nujmmlmﬁwm Taedl S0 way S1 1 dusmvuntisdyguanudd

Ao3n13 danndyaad OF vihwmthiinauaunsiUaldauiaztanisldauvesdyaaeidne

FIEADUAUBITNHYYINADIN “0” lALUARINTTYINNURIFUT 2.4

TAOS TCS230
(TOP VIEW)

I e M
| Photdiod Current4o-Frequency | |
Light | Amay Converter |
I
L=
[ r
s2 Ss3 S0 S OE

(@)

Ul 2.4 1umes TCS230
(n) Tassasrawasladuaaduwas TCS230 (v) vdanlaazwnsunisiianuvesdulgas TCS230

(flan: http://www.ett.co.th/product/robot/tcs230/ET_TCS230 Manual )
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2.2.1 AuuanURvaLTuwasinddang 31
1. Wieauazidenvesradnsgs (Annnnsuasanuduveuatluidu
Ad fo (Frequency Output))
2. @130 UTUATUEDNATINTAFN AN O IAINABINIT WA NUUATEAY
Fryaunauen@ng fo (Frequency Output) 1ol
3. asavinsdeusedyaasing o dhiulilasreulnsaaeslélaense
4. naufiusadiu 2.7 1ad 8 5.5 Taad
5. T€5230 Wuduiiilauand@ldmdmalniigi
6. AnAuAaIMAAeY 0.2 Waddud inud 50 Aladdn
7. vaealiueadadmiunisasvioudvesing
2.2.2 vdyaadlunislganu
1. 91 VCC A vdanadlidssusssulniuan 5 Taad

(3

2. 91 OUT Aa ndaynasordnm lagliaanuiesnuniuanud (fo) 1y
gﬂﬂau—ﬁLwﬁam mnunf1eiad 50 wWesidus Fermnuiazudsiunurvesuasiinnnseny
BUAYDINALN DT

3. 91 S0 wazan S1 undannaidensefuresdynunuiiendne e
Fonldnulimnrauiulilasnouaes Insannsaidenls 4 sedu assseluil

[y

‘!. o o ld' 3
f197997 2.1 NTANUATEAU UIUAIHALDTANA VDIV SO wae S1

USudaaiin
Output frequency scaling
SO S1
0 0 Power down (Liindndaayraueanud)
0 1 2 Wosigus
1 0 20 Wosidun
1 1 100 Wosiua

(55

NeT197 2.1 TneunAnndueesindndeuseriululasreulvsamesengluildly

[% o
v 2 v

TUsaadl Tnenisusuadu 20 wWosidud satudsdeanliluluswnsulven so Wy 1 wazan

S11u 0
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4. 41 52 waz S3 Wundygraildidenvinvesiiamesvednlalaload

A99N1591UANNINNTIRD lUT

A1519% 2.2 nMsmvunviavesilawmesvedldlalonifesnisindayyio

USudaaaiin
Usznnlilalalon
S2 S3
0 0 LA
0 1 RIS
1 0 Litfawes
1 1 KIe)

£
a v 1

NATNN 2.2 N5 NUIsLduLesTaalulusiand YauAfiaaaniziioamnua
LLmﬁamagﬁ’Uﬂizuamﬁuam sratiulunisaerlulusunsudadenldvn S2 Wu 0 wazwn S3

Wu o

5. 91 LED Wuvnndgaadildlunisauaumasalvieadilifinaine w3s du

[
Y

MalnINFRIN1INAEAIVANNITINNIUYBIMEADAINYIE TR NS EaNTN 05 U1

1A o | A Y = ° o aav v
LTI (PC) 28783998a115091INITAIUANNITVINIUVDIVIADALDRTRA LA

2.3 LS9898A7

U

ws3aed [4] Tunseenuwuvasiadanlasediluvadivals wu (5o 15ed1un a9

ANTNRIANTL A TN WA LU UL UDIAAANITNANAINLA FIUUEAD U TADINANNT

1%

fugiludeuiediunsiaeudn AALINANTBILTINGY UAZAINFXIAYUATN LUy
szituldinflefngauiiissunafissusdruniesniualuredlua aziinu 591
3 ing TunwininiuRivesduwseinerenungwisesningliaostu Tuiianisaiu

mMafuusaiagaedlan 15138071 U39a0Y (Buoyant Force) Wagiuniaiusiaasfiinsgyi

VTl 139071 9AAUENA19TaesIa (Center of Bouyancy)

ATAUNULIIA0EFT fa 15Alea naalidn “Wedngla 9 auegluvedlnaliinay

(%
[y

Junmuaniounsdiu sxfiussassiuinszyiiuingiunazaziiawidudmdnvesvedlia

1%
LY tY s

P A, | ) aaa . . .
NYNINQUULNUN 138NN NaNNI5VDID19ANAE (Archimedes Principle)
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2.3.1 nsalingaunsfiou

(%
o v o

n3UN 2.5 dbiingadluvedvanumdndumsintiu Y ussansveauss

6

TulwIs1u (Horizontal) adiAwinfiugwd

JUN 2.5 Wedngasluveslvanaieu

(MU auns gvduin, narmanivedlua(2558), gnssil)

duludiuninie (Vertical) A159M915001 wris MN Fififuiintise dA
FIUUY AILALY M eziussiurosveamal dawyindu P1dA

FTUANT AILALS N 98l 59AUB9YBwMaT HANNAU P2dA
Fanudu P ity yh

LALa1 P, 11AN31 Py 5 AINULANATIY89AINNAY AEVMALAALSIAUABEAITU

= a1 1

Fg @95A9IAUIAENTSLUS 8 ULABURINAINLANG 19VDILSIAUYDIVDURAINALIAUY M Lay

N 19 A9aun157 2.1 hagaun1si 2.2

dFB = PZdA - PldA (21)
dFg = Y(h, - hy)dA

dFg = YydA (2.2)
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1Y

muuali dV fe USuinsveausis MN Ainasfiansann winiu ydA Tugunisi 2.3

dFg = YdV (2.3)

At WitaREMTIN YuansziiuingIadudsaunisi 2.4

FB = [dFB
Fg =/ YdV
Fe=YV (2.4)

2 '
v YV )

naun1sesurelaingt V iulsuinsveadingisnaunauluvedlvaldinsiasssi

q

(%
(Y] Y

Fs azwiriudintdnvedlnangningnineuunui (YV) uazusellaznseinniugaaudais

a

(centroid) vasinananluvaslna

1

2.3.2 nsnlingaseegszninevadlva 2 vila

bl

(%
o v o

N3UN 2.6 iinganlureslnanivdndinisduuuuagandliniiu Y,

waz Y, MUAIRU Fensanla 91naunsi 2.5 wazaunisin 2.6

dFg = P,dA - P,dA (2.5)
dFg = [Yi(h; + y1) + (Yay2) = (Yih)IdA

dFg = (Y1y1 + Yay2)dA

dFg = (Y,dV; + Y.dV>)

Fe = /dFg = J(Y,dV, + Y.dV),)

Fe=Y.V, + Y.V, (2.6)

91naun1esulaing Y, uazr V, Wudsuinsvesingfianluvesing

(%
[y

AUUULATATUAN AUEWULTIRBET Fy 3uvzvhivdminsinvesvasiangnunuinig

[y

MOUALALMLNYAANONAIVBILTIRRERT AwRYNFUNLAAUdaIeSNnTYeIvesiva

wrazlafigningunui wazasdudassdsiunasiu

Y
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5UN 2.6 Tngauluvedtiva 2 viln

(MW quns gvsuin, nasansveslna(2558), gnssil)

2.3.3 nsalingaseagiviloda (Huredwasluvadiva)

sUN 2.7 Ingauluvedlvauisdiu

(MW quns gvisuin, nasansveslna(2558), gnssil)

n3UN 2.7 liingasgegwilervselivisdiuatedluveiva asnui
nmsfiasanidudnieriuiunisanegseninaesiva 2 viia isizeiniaiiluveslvaiiy
a
Aen

wsitilasaniinindinizveseiniAlaiUTeuliguiuvounaIudl A

WANA9AULNN FaldnuNaTaun



AeulsRgiveumaInseiseingazliavinduing svlawviriuidimidn

q

—

' (%
[ 1 a v v a 1

YRR IngAIUNIUWIUAGRMEdINNAY) umdwiiudminvesingnineudneiey

9 9

Y

Feuuaunsi 2.7 lensil
Fg=W =YV 2.7
e V Ao Ysunsvesingludiuiiauveaval (m?)

2.4 1aAUAY (Control Valve)

Ndmuan [5] Nawmuauiiane Naaudugunsaliildmuauiianianisivaves
audalufiamaidesnis wunsldmuaumsiadeuiivesiugureanszuenay lugunsalau
szuuiwing dulimsGendenmudnumsvend s

1. ledueesnnda (Solenoid Valve) fondrimuiiamisan fuuuiausenisida-
Unndn viSeuuundimueuiiana fuvu 2/2, 3/2, 4/2, 5/2, 5/3 1 dnusneneedlii
(vaaanlniileduees)

2. Twduseimdmuaunsiva (Flow control Valve) Asndaiimunuiiavisasvie
yoslva wu 2/2 e dnuseasedlnih @aainliiilsdussd) shnihide-Unndn

3. 2187PUANMBLIIAL (Air Control Valve) W3931d78u Aenndrfiaiuaumisay
dnushean Wa-Tnndn

4. 1Md1muAudaenaln (Mechanical Valve) Jufuuszinnnisldanu du 11
muAusEle NdIMuANBY1 NdmuaNsenalamakamia wazdszamd o

lngnanagldlulusianil uanidegun 2.4 Aaleduaeningdl lagviinisaiuaunis

Wa-Unnadannsaiensed b
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5UN 2.8 sUsvadlefiuegning

2.5 a3 iausenuay (Pressure sensor)

<@ 6 [ A & o [ (% Id
Wuwasiauseduay (6] Ao aunsaifldlunisinussiusazwlasdyaineanunidy

' [
aa v o o

Fyanannnspuniivisdayayimeunden 4-20 Tadueud 0-10 basmeurdygraluaruaui

lulasmaulnsataasiveldlunisiawsenuanludiauuaziionsasuaunialudausinii 2 uns

a

ey ¢ | o I s v Y N a o o
rddlindmeninga lnsdnvazveuduweiintssiuauiinlilulusiandidnuuy degy

29

b

JUN 2.9 sUTveduwesinANi AN

(#ian: http://www.elecsensor.com)
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Tnafuwes Tuswiuanuisssnngesnumdnnisvienlésd

1. AN (Strain Gauge) ndnnsvaufsedan1sdanasives Strain gauge 7ion
Anegfuusulnozurisuuaziensasludasas Inalauuing (Wheatstone Bridge) Lilaudag
AU (pressure) Tutdudayayramialni

2. f&uuns (Thin Film) Wudumesdnvasuiufiduuns 4 fesdunsinaudinanad
usafueenu Sesldfunuidusiusi

3. M@ (Thick Film) laeginsaesdnanan wu wiln mnefunuiduseiy

= I3 ' as a a
N Tanuudatsannninuszinniiauuns dedlelunulensedn

| 4
2.6 5ta¥ (Relay)

3188 [7] Jugunsalfivdoundsnuliiiliidundinuwiman ieldlunisfga
PduNavaInauwnAliiUdsuannzlaen1staunsewaliidliduunain evinn1sUanse
a Y o o % ) A 6a & A 6 = o a
Uanthdudardeiuainddiannsetind dasnaunsaunsiadluussgndldlunisaiunuieas

A 9 Tusudedidnnseiindunnung

5Ufl 2.10 S1ad

(Fun: https://www.psptech.co.th)

n3U7 2.6 Tulusiaail Sadliinszuanss 5 1aad gﬂﬂmﬂﬂumuﬂua%ﬁ%—

6

Unadndian Mazdrsandilulunssueniiniduwesindinamuduasiiegfinszuen uassiad

Inlnseuaadu 220 Tiad gnihanldmivaunisinnurenavsamvaeulniiau Welwidu
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szvhlisasiiihdsdyaaussiulng 3 Thad Withilasnoulnsaaesiudyanadslinig
yhoududuvesadosdisedluliniy
2.6.1 druusznauvasiiag
UsgnaumediudAey 2 dunan A
1. druvosvnadn (coil) viwehiisuussdulaiin umieinszualndiium
asauuudmdnlnilunsinlifganihdudalitefieiu (@uswuiitiaddonistui
ilauazunuiRan e
2. druveanihduiia (contact) simihwmiloufuaindiidmunnisiln-Un
nsensewalninlviiugunsal
2.6.2 yadaldauvasiiag
RpliNUINTTINUTENB UG
1. 9969 NC 6811190 normal close wangauIUnAndn n3a nndaly
Prenszudlinlivamauienihviduiassintu lnevlusindeqeidhfugunsaivie
wnadldluihiidesnsliminunasnina
2. 3618 NO 6831970 normal open maeANNINUNALTUR wamndalaiing
nszualwil liunmnmionhuidudasslifatu Inemluisdinsegniliiriugunsaivie
weesldlwihfiFesnisnuaunsda-Ua
3. 9990 C 8831N91n common AegnsnTinesNINLMasT el
2.6.3 Uszinuassiad
Jadifugunsaliminiiduaindaiuaunisinudgliiiuaeenan
anwaznsldouladu 2 Ussande
1. S1adn1a9 (Power Relay) n38L58n31A8ULNNLABS (Contractor or
Magneticcontactor) THlunsauaulwinfisiindsge azdidnvaznalngniiadimly
2. Stadeunu (Control Relay) Tlunsauauiiluiinsldmaalniligs
11N viseldmuAusadmaeniits sslidnuazuuiean
2.6.4 ¥lavasIiad

SidnealdanunazIaniuwnivany 4 ¥ila

1. 9151L99331a8 (Armature Relay) w3a3tadunaliues (Clapper Relay)



o
L3 (9

2. JAnauwnnsiad (Solid-State Relay) UuSiadifitnsie 2 17 1adedunn

3
)=

Jutrdmsuloudygruniuau wiedsdutaednalunisda-Uaees Ja5iadviaiilald
lassaamanasgniely uragdnisueniumdliihseninaidunnuaziodng

Cs ¥ U

3. 33188 (Reed Relay) Wusiadffldnwasaaiaiuualgavuinian fa3n-

SiadUsznaumewiuanu1e 2 uwiu ussqeglunasauiiniianainiuegseu o Welin

=3

nszwalnanIuvnaIn s RnaUILWIWEan TasauullinanasiulikumanNasdutiany
4. 3aa3nd (Reed Switch) JuSiadnlifignunairndiniunisadna
] @ 1 £ a a, Y v W a 4 1 @
aunuwiwmanlii udagldnismuaunisle-Uavihduiavesaindanauuuidmannieuen

WIAUANNTNAUN

2.7 wasindalvifinssuaadu 3 Wa

insearufialili (Generator) [8] Ae auUnsalfiutamndsunadundanului Tng
91ABNITUYUIUTDIVARINAAAUAUINKILIAEN WS081FBNITNYUIUTBIAUURIRANARY
ynmslaguvaadosiudalnih eenldidu 2 viade

1. wsesndalinssuaadu

2. 1Asedndalniinssianss

JUN 2.11 in3esillalniinssuaadu 3 wia

(fian: https://www.indiamart.com)

N3N 2.11 wnsesindalihaldlulusiaeil Ao wissiidalinssuaaduany

wladinsasu 12 1as magknia 100 Jae
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Tnawnosidalniannsautsoanlaidu 2 dw fe
1. ndesuids Wudusidandsnunavesaisssudalnihesnun
2. fandandsuiindnnisiinude n1serdenismiieadiauiuudindn
dieliuiandsnuluedostuialuih Taedl 3 sunuy fail
1. wuuyjumnyu (Revolving Armature Type (Ra Type)) dannis
yhaulngnisednisvuresunaInneaLad JainsiueguinanduLnuimasuia U3
Fuussushadn vnlmannswienhliihguiivansvesaaiameuns
2. LLUU%QLL%JLMﬁﬂW,;Iu (Revolving Field Type (Rf Type)) dinannis
ﬁmuimmimﬁamimgwuaaﬁﬁgaLLajmﬁﬂﬁagjuume Faapyhlidunsaiindndausinm
szawmmLmaﬁamagjmqmﬁaﬂ lRaussuliiusnaenaaeun sty
3. wuuhidnaslduyssanu (Brushless Type (Bl Type)) fndnns
auiielrsdenduluadesdulilaoeniy Feazlddnsldudsearuiiomisn

WANUTRIAUINWIWAN SussiliAnnssualiimienihadnanenazainsonuaule

28190UsEANS AN



uni 3

N3N UU

Tuunilnga11894n1999NLUUTZUUNITINU TagdUADNZLATUNITVIIUUDITUIIU
A1589NLUUINIT N158aNLUUINAIVISANITYINIUYDdlUswNsULATe9a1509 NN Tne T ws e
A98A199991N1AN8 UL LAEN15eeNLUUIATIAS 191D LATRId 50 TN TneTdwsanesvag

PRIRGRRBIVVR

3.1 vaanlaazunsy

A48y

W nszuagau
220 Thad

I I

29956157980V aaulnsalaay - 3 o A
> 31a8 5 12aa MANUa-Unay

TWeu a1qlelu 815 3

i

< 1 s
W ULLDINSIAIUA

i

waudnfneagiu

U3 InANUAUAL

nszuaniAuay

UM 3.1 vdenlaszunsunisvinauvesasssdisesinihlagldusiassdivesenianiglui

31n3UN 3.1 vdenlaezunsunisvinauvesaiesdsesinilaeldusiassdives
a1nanelul A nszwaadu 220 Thas Knur9asasirasulnidngu lulaseeulnsaians
91lugli 015 3 Wumyszniamaiudunmaniduresinnuduanvesdeay Wuiwes

v o aaa Y] I3 3 Uy ¢ ¢ A v ¢ a A
Wi?ﬁ]ﬂUﬁm@ﬂLLﬂUﬁﬂm@@% UﬂﬁgU@ﬂaﬂJLLagLUUL@qmwmiﬁiLaﬂ 5 I’Jam LW@IV?W@ULUW-U@@QJ
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3.2 Wadvdnnisvinaunsasdrsasliinlaeldussaassfivasanianieluun

- W
( LIUAU )

4

299550V
Tvighéu

Taily T
Tylfhéu
o
/ Wugasnsind /
1aile
=
ATDANUALA
Taf

Ausadua < 2 vs

y

Sadazlivianu
S )
Ma8ausln

Wuwasinanuduay

Fuanuwes Iannuduay

AsIdua > 2 u1s

h 4

= ¢ -

LagawNINUY
(# -

1MaaEiUn

(aumsviau)

5UN 3.2 Trladysanisvihauveansesdrsedliitlagldusiasediveseinenisluul
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9n3U7 3.2 Julvadansanisinuvewniosdisesinilagldusaessiveseinie
aelu AgFud1n19neasasaeulnihduinliirfinegusedulyvseld anlyaslv

v 3

Lo 3ns19udilielreduniNfineg NAanseuoniuaNIINUUIZL IAA LS IR UANNTUL

'
[

ANTUD T IALTIFUANITLTIFULINNIT 2 V1S vSaluduinnnin 2 1S aedslrsiadvinau
Waazyinnsianatananntufaziundulusumand uiwesnsaduansness wazazduay
W lUlunssuanay wia1teenii 2 U1s Stadazluvinauinalauazlidle anntuazaunng

YIN9U

3.3 NN92dNLLUUNT

3.3.1 29955702 wATa9d1509 A e 1S eavenvasaInAnNT8 TN

p+12V
Solenoid
USB Connector Valve
SOURCE GND
7to012 GND

13
12

5V 1 1

GND 10

Arduino 2 Q1
UNO R3 2N7000
4
6
m W A0

Al i

A2 B

A3 2 -

A4 1

X : |

‘w NC ONO
Relay AC
220V
COM
OUTPUT
Sensor R7
—T®GND Pressure 10kQ
Transmitter
— 5V

5UN 3.3 199557UVBITEUY
INFUN 3.3 HATTINVDITLUUYTENBUAIY 3 ARl
1. dudune (Input) Ysenaumea99snsadulnihdudsdygiauwuuiines

(Digital) Wousaiuw1 D2 WulwesnTiaduddedyauuuuiinealfsusenuun SO fuwn D4,

91 S1 Auw D5, 11 S2 Auwn D6, 91 S3 fuwn D7, 91 OUT Auw D8 1aen1sadAIvadnIsad-
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fuanamendumesindarusuntsselulusunsumumsneit 2.1 way aseit 2.2 finanals
Tuunil 2 waniiuwesTaruiuandsdyiauuuewnden (Analog) Weustaiuan A0

2. dauuszanana (Process) lulasaaulnsataesenglugly 815 3 10w
muAuRsUABunALar USRIl Un-Unlvausssing

3. daule1dnm (Output) Usenausiesiadaiuaunisila-Unvesleiuess
Médendeiun 3

3.3.2 2925 AaU

R1
(o 10kQ
O__
no O Nc
AC - O R2
220V elay ] 3kQ
CcoM

+“ I___ EJ Input D2

12v

U 3.4 2asnsiaaeu v

93U 3.4 Dwinasaseaeulnih Wesdeiwwsasaaeulnihaudniviad
Welniheausiagsalidswn NC et lwainwuamas 12 1iad W uds Uiy R, way R,
| =~ v A 1 I [ & 1 1 3 o
Aouuuvtuieanussrunrdnudyaralilulasreulvsamesonlugly 1% 3 vieu

TAgNIULTIAU Vour Naaussduasiiossdaidudgpyialula

lulasmoulnsames-angligly 013 3 veu 91naunisi 3.1

VOUT = Vm X (RZ/R1+R2) (31)
Vour = 12 V x (3 kQ/10 kQ+3Q)

Vour = 2.76 V

o Vour fie wissumdudyaalilulasreulvsaaeseigiugly a1s 3
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R; A9 ANATUNUYBIFIAU R,
R, A9 AUAIUNIUYBIAINU R,

3.3.3 299515 LUALNDS

RXEF110

R4

D5 1kQ
1N5822 +

= :@: _
D6 12V=

LED

U 3.5 2993B15UUALADT

mﬂ'gﬂ‘ﬁ' 3.5 Lﬁmqaim%ameLma'%leuaﬂsqmmuqmmiﬁﬁmmaaLﬂ%"aﬂﬁﬁaa
Tilneldussaesivetonnianeluti welwihnszuaadu 220 Thad WWauldund 2995-
yr5aazvsaluiliiuuunnes 12 Tad iefagliuunmoidroussiuliganiugunis
Mauvenmsoilensuliiigu Tagrsasersanumaeiasd Tod LM371 Wuledsnunsesu
w59 Tneasiiusssunnasoudidasuniu R, Wuussiusnada Ve Savindu 1.25 Thad 39
Lid]mt,iﬁumaG»mﬁhmiwdwl,mﬁul,a’]ﬁwmﬁuLmé’uﬁmﬂ%’um LAYNTYLE |, V09 bod

LM317 flfn 50 lulaswaud

WAL ST MNAYedled LM317 naglumsanunwasla naunisin 3.2

VOUT = VREF (1 + R2;1R3) + IAD] (Rz + R3) (3.2)

2kQ+2200Q
220Q

=1.25 v(1 +
=1397V

) + 50 WA KQ + 220 0)

e Vour fie ussdwodnnvedled LM317
VREF A9 4530ue198959inavednniuausuan
R, fio Aanudumuvessiiinuniu Ry

R, A9 AIAUAILNIUTDIRINTUNIU R,



R3 A9 ARUAILNIUIDIRINTUNIU Ry
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TUswnsuvansasdnsaslnilangldnseananivasainidanieluin

#define data_pin Al //Uszmevisuleesinnsanuay
int valvepin = 3; //UsenAvSLagee9INalay
int buttonPin = 2; //U5eNAvIU8939350M 5@ UL NN GU

//\BUBSRGB ASI9TUAWALINTEUDN

#define SO 4 /AlsgmAvIveaduesnsiaing
#define S1 5 //dsEmAnveLduesnsIving
#define S2 6 //JsEmAvedueesnsIvIng
#define S3 7 /AssmAvveduesnsiaing

#define sensorOut 8 //UsenmAvnusadulyasnsiaing

int frequency = 0;

int buttonState = 0;

int i=0;

void setup()

{

Serial.begin(9600);

pinMode (valvepin,OUTPUT); //atadilalnanaaau

//RGB

pinMode(S0, OUTPUT); //\Gueesnsiaind
pinMode(S1, OUTPUT); //\Guesnsiaind
pinMode(S2, OUTPUT); //\FUesnsI19Ingd
pinMode(S3, OUTPUT); //\Buwesnsaing

pinMode(sensorOut, INPUT); //Aduesnsiaind

pinMode(2,INPUT); //vasasiageulniisu
digitalWrite(2,LOW);
digitalWrite(S0,HIGH); //\FU0InsIIndnUA RS UAIYDIELAS

digitalWrite(S1,LOW); //\FU0InsIInANAUA RS UAIYDIELAS



void loop() {

buttonState = digitalRead(buttonPin);
Serial.print("buttonState :");
Serial.printin(buttonState);

iflouttonState == HIGHY  /alnihauazsuudygransasanagaulingu

ATUNTITVINUY LT UL DS TR SIS UAL

int sensorVal = analogRead(data pin);

float voltage = (sensorVal*5.0)/1024.0;

float pressure_pascal = (3.0%((float)voltage-0.475))*1000000.0;
float pressure_bar = pressure_pascal/10e5;
Serial.print("Voltage:");

Serial.print(voltage);

Serial.printtn("V");

Serial.print(" Pressure:");

Serial.print(pressure_bar);

Serial.println("bar");

Serial.printtn();
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//RGB

digitalWrite(S2,LOW);

digitalWrite(S3,LOW);

frequency = pulseln(sensorOut, LOW);

Serial.print("R= "),//printing name
Serial.printin(frequency);//printing RED color frequency

Serial.print(" ");

if(i==0){

digitalWrite(valvepin,HIGH);

delay(2000);

iz1%
}
if(frequency <= 170) //aapdunsdatouninnaawindu 170
{

if(pressure_bar > 2.00) //Aussnuandainnnndi 2.00 u1s

{

digitalWrite(valvepin,HIGH); /&R adinundauazida

delay(250); //Mtaaaan 250 Jadiund
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if(pressure_bar < 2.00)

{
digitalWrite(valvepin,LOW);

}
else
if(frequency > 170)
{
digitalWrite(valvepin,LOW);

}
else if(buttonState == LOW)

{
digitalWrite(valvepin,LOW);
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//81l4iednnediAnu1nnin 170

//&dlsadlalvinaundianasle

//enniAnagSuudaansasasadeulnilsu

//&dlsadlavinaundianasle



AMANUIN U

Adan1slduatasdrsasivilagldussaseiivasernianigluin



dordumalulagnszaauinaidnaunisainnszds

INYNVAYUNTLVATYANAND I IAYUNS

Un1sinuen 2564

60



61

& )
YUABUNIT LYY

1. vimaidgudanii Ineduaninvestuay uazdanlnvesndespeulnsa fdagui 2.1

Uil 2.1 1@eudanlal

2. nAans ON Ainasdraulnsa

5UN 9.2 neadnd ON Nindespaulnsa

3. 5EUVILINNUSRIUTR dasnalUdl



62

3.1 fanazyhnmstuaniuiludwuduvas il dlds

3.2 ielduniasdsesiniilngldussassnvesenmanielutheinig
Uaswaudn Tlunszuen lngldiduwesnsiadudidudnsiadulunssadnluly
nszuemilsiadesvisu

3.3 iedosdsadlilnglfussaesiuosonianieluisnganisvinude
auludsauinde 2 U1s

4. vnnssdsulanin wiveldlndrsesvaslwilney

Ul 2.3 Udnlileldlnidrsosuas ity



AMANUIN A

adan1slderugunsal (Datasheet)



Arduino UNO
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Product Overview

The Arduino Uno is a microcontroller board based on the ATmega328 (datasheet). It has 14 digital
input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16 MHz crystal oscillator, a
USB connection, a power jack, an ICSP header, and a reset button. It contains everything needed to
support the microcontroller; simply connect it to a computer with a USB cable or power it with a AC-to-DC
adapter or battery to get started. The Uno differs from all preceding boards in that it does not use the FTDI
USB-to-serial driver chip. Instead, it features the Atmega8U2 programmed as a USB-to-serial converter.

"Uno" means one in ltalian and is named to mark the upcoming release of Arduino 1.0. The Uno and version
1.0 will be the reference versions of Arduno, moving forward. The Uno is the latest in a series of USB
Arduino boards, and the reference model for the Arduino platform; for a comparison with previous versions,
see the index of Arduino boards.

Technical

Specifications Page 2

How to use Arduino
Programming Enviroment, Basic Tutorials Pa g e b
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Technical Specification

EAGLE files: arduino-duemilanove-uno-design.zip Schematic: arduino-uno-schematic.pdf

Summar
Microcontroller ATmega328
Operating Voltage 5V
Input Voltage (recommended) 7-12V
Input Voltage (limits) 6-20V
Digital I/O Pins 14 (of which 6 provide PWM output)
Analog Input Pins 6
DC Current per /O Pin 40 mA
DC Current for 3.3V Pin 50 mA
32 KB of which 0.5 KB used by
Flash Memory Eostiaader
SRAM 2 KB
EEPROM 1KB
Clock Speed 16 MHz
the board
o ER1
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Power
The Arduino Uno can be powered via the USB connection or with an external power supply. The power
source is selected automatically.

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The adapter
can be connected by plugging a 2.1mm center-positive plug into the board's power jack. Leads from a
battery can be inserted in the Gnd and Vin pin headers of the POWER connector.

The board can operate on an external supply of 6 to 20 volts. If supplied with less than 7V, however, the 5V
pin may supply less than five volts and the board may be unstable. If using more than 12V, the voltage
regulator may overheat and damage the board. The recommended range is 7 to 12 volts.

The power pins are as follows:

* VIN. The input voltage to the Arduino board when it's using an external power source (as opposed to
5 volts from the USB connection or other regulated power source). You can supply voltage through
this pin, or, if supplying voltage via the power jack, access it through this pin.

¢ 5V. The regulated power supply used to power the microcontroller and other components on the
board. This can come either from VIN via an on-board regulator, or be supplied by USB or another
regulated 5V supply.

* 3V3. A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50 mA.

* GND. Ground pins.

Memor

The Atmega328 has 32 KB of flash memory for storing code (of which 0,5 KB is used for the bootloader); It
has also 2 KB of SRAM and 1 KB of EEPROM (which can be read and written with the EEPROM library).

Input and Output

Each of the 14 digital pins on the Uno can be used as an input or output, using pinMode(), digitalWrite(), and
digitalRead() functions. They operate at 5 volts. Each pin can provide or receive a maximum of 40 mA and
has an internal pull-up resistor (disconnected by default) of 20-50 kOhms. In addition, some pins have
specialized functions:

* Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. TThese pins are
connected to the corresponding pins of the ATmega8U2 USB-to-TTL Serial chip .

* External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a low value, a
rising or falling edge, or a change in value. See the attachinterrupt() function for details.

*« PWM:3,5,6,9, 10, and 11. Provide 8-bit PWM output with the analogWrite() function.

* SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI communication, which,
although provided by the underlying hardware, is not currently included in the Arduino language.

* LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is
on, when the pin is LOW, it's off.

[::] Radliospares RADIONICS
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The Uno has 6 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By
default they measure from ground to 5 volts, though is it possible to change the upper end of their range
using the AREF pin and the analogReference() function. Additionally, some pins have specialized
functionality:

* I’C: 4(SDA) and 5 (SCL). Support I°C (TWI) communication using the Wire library.
There are a couple of other pins on the board:

* AREF. Reference voltage for the analog inputs. Used with analogReference().
* Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset button to
shields which block the one on the board.

See also the mapping between Arduino pins and Atmega328 ports.

Communication

The Arduino Uno has a number of facilities for communicating with a computer, another Arduino, or other
microcontrollers. The ATmega328 provides UART TTL (5V) serial communication, which is available on
digital pins 0 (RX) and 1 (TX). An ATmega8U2 on the board channels this serial communication over USB
and appears as a virtual com port to software on the computer. The '8U2 firmware uses the standard USB
COM drivers, and no external driver is needed. However, on Windows, an *.inf file is required..

The Arduino software includes a serial monitor which allows simple textual data to be sent to and from the
Arduino board. The RX and TX LEDs on the board will flash when data is being transmitted via the USB-to-
serial chip and USB connection to the computer (but not for serial communication on pins 0 and 1).

A SoftwareSerial library allows for serial communication on any of the Uno's digital pins.

The ATmega328 also support I12C (TWI) and SPI communication. The Arduino software includes a Wire
library to simplify use of the 12C bus; see the documentation for details. To use the SPI communication,
please see the ATmega328 datasheet.

Programming

The Arduino Uno can be programmed with the Arduino software (download). Select "Arduino Uno w/
ATmega328" from the Tools > Board menu (according to the microcontroller on your board). For details,
see the reference and tutorials.

The ATmega328 on the Arduino Uno comes preburned with a bootloader that allows you to upload new code
to it without the use of an external hardware programmer. It communicates using the original STK500
protocol (reference, C header files).

You can also bypass the bootloader and program the microcontroller through the ICSP (In-Circuit Serial
Programming) header; see these instructions for details.

The ATmega8U2 firmware source code is available . The ATmega8U2 is loaded with a DFU bootloader,
which can be activated by connecting the solder jumper on the back of the board (near the map of Italy) and
then resetting the 8U2. You can then use Atmel's FLIP software (Windows) or the DFU programmer (Mac
OS X and Linux) to load a new firmware. Or you can use the ISP header with an external programmer
(overwriting the DFU bootloader).

@ Radi/ospares RADIONICS A
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Automatic (Software) Reset

Rather than requiring a physical press of the reset button before an upload, the Arduino Uno is designed in a
way that allows it to be reset by software running on a connected computer. One of the hardware flow control
lines (DTR) of the ATmega8U2 is connected to the reset line of the ATmega328 via a 100 nanofarad
capacitor. When this line is asserted (taken low), the reset line drops long enough to reset the chip. The
Arduino software uses this capability to allow you to upload code by simply pressing the upload button in the
Arduino environment. This means that the bootloader can have a shorter timeout, as the lowering of DTR
can be well-coordinated with the start of the upload.

This setup has other implications. When the Uno is connected to either a computer running Mac OS X or
Linux, it resets each time a connection is made to it from software (via USB). For the following half-second or
so, the bootloader is running on the Uno. While it is programmed to ignore malformed data (i.e. anything
besides an upload of new code), it will intercept the first few bytes of data sent to the board after a
connection is opened. If a sketch running on the board receives one-time configuration or other data when it
first starts, make sure that the software with which it communicates waits a second after opening the
connection and before sending this data.

The Uno contains a trace that can be cut to disable the auto-reset. The pads on either side of the trace can
be soldered together to re-enable it. It's labeled "RESET-EN". You may also be able to disable the auto-reset
by connecting a 110 ohm resistor from 5V to the reset line; see this forum thread for details.

USB Overcurrent Protection

The Arduino Uno has a resettable polyfuse that protects your computer's USB ports from shorts and
overcurrent. Although most computers provide their own internal protection, the fuse provides an extra layer
of protection. If more than 500 mA is applied to the USB port, the fuse will automatically break the connection
until the short or overload is removed.

Physical Characteristics

The maximum length and width of the Uno PCB are 2.7 and 2.1 inches respectively, with the USB connector
and power jack extending beyond the former dimension. Three screw holes allow the board to be attached to
a surface or case. Note that the distance between digital pins 7 and 8 is 160 mil (0.16"), not an even multiple
of the 100 mil spacing of the other pins.

@ E\ Radiospares RADIONICS A
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How to use Arduino

Arduino can sense the environment by receiving input from a variety of sensors and can affect its
surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is
programmed using the Arduino programming language (based on Wiring) and the Arduino
development environment (based on Processing). Arduino projects can be stand-alone or they can
communicate with software on running on a computer (e.g. Flash, Processing, MaxMSP).

Arduino is a cross-platoform program. You'll have to follow different instructions for your personal
OS. Check on the Arduino site for the latest instructions. http://arduino.cc/en/Guide/HomePage

Linux Install Windows Install Mac Install

Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USB cable.

Blink led

Now you’re actually ready to “burn” your ot _a®
first program on the arduino board. To
select “blink led”, the physical translation
of the well known programming “hello
world”, select

int ledPin = 13;

File>Sketchbook> The setup (). method run
Arduino-0017>Examples> void setw ()
Digital>Blink inivializ

pinMode (ledP;

Once you have your skecth you'll
see something very close to the
screenshot on the right.

In Tools>Board select

Now you have to go to
Tools>SerialPort

and select the right serial port, the
one arduino is attached to.

° Done compiling.?

Press Compile button

[emR
(to check for errors) Upload TX RX Flashing Blinking Led!

@ @ radiospanes RrADioNics /]
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Dimensioned Drawing
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Terms & Condifions 19:°)

1. Warranties

1.1 The producer warrants that its products will conform to the Specifications. This warranty lasts for one (1) years from the date of the sale. The
producer shall not be liable for any defects that are caused by neglect, misuse or mistreatment by the Customer, including improper installation or testing,
or for any products that have been altered or modified in any way by a Customer. Moreover, The producer shall not be liable for any defects that result from
Customer's design, specifications or instructions for such products. Testing and other quality control techniques are used to the extent the producer deems
necessary.

1.2 Ifany products fail to conform to the warranty set forth above, the producer's sole liability shall be to replace such products. The producer's liability
shall be limited to products that are determined by the producer not to conform to such warranty. If the producer elects to replace such products, the
producer shall have a time to Replaced products shall be warranted for a new full warranty period.

1.3 EXCEPT AS SET FORTH ABOVE, PRODUCTS ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." THE PRODUCER DISCLAIMS ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, REGARDING PRODUCTS, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE

1.4  Customer agrees that prior to using any systems that include the producer products, Customer will test such systems and the functionality of the
products as used in such systems. The producer may provide technical, applications or design advice, quality characterization, reliability data or other
services. Customer acknowledges and agrees that providing these services shall not expand or otherwise alter the producer's warranties, as set forth
above, and no additional obligations or liabilities shall arise from the producer providing such services.

1.5 The Arduino ' products are not authorized for use in safety-critical applications where a failure of the product would reasonably be expected to cause
severe personal injury or death. Safety-Critical Applications include, without limitation, life support devices and systems, equipment or systems for the
operation of nuclear facilities and weapons systems. Arduino | products are neither designed nor intended for use in military or aerospace applications or
environments and for automotive applications or environment. Customer acknowledges and agrees that any such use of Arduino | products which is solely
at the Customer's risk, and that Customer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

1.6 Customer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements conceming its

products and any use of Arduino | products in Customer's applications, notwithstanding any applications-related information or support that may be
provided by the producer.

2. Indemnification

The Customer acknowledges and agrees to defend, indemnify and hold harmless the producer from and against any and all third-party losses, damages,
liabilities and expenses it incurs to the extent directly caused by: (i) an actual breach by a Customer of the representation and warranties made under this
terms and conditions or (i) the gross negligence or willful misconduct by the Customer.

3. Consequential Damages Waiver

In no event the producer shall be liable to the Customer or any third parties for any special, collateral, indirect, punitive, incidental, consequential or

exemplary damages in connection with or arising out of the products provided hereunder, regardless of whether the producer has been advised of the
possibility of such damages. This section will survive the termination of the warranty period.

4. Changes to specifications

The producer may make changes to specifications and product descriptions at any time, without notice. The Customer must not rely on the absence or
characteristics of any features or insfructions marked "reserved” or "undefined." The producer reserves these for future definition and shall have no
responsibility whatsoever for conflicts or incompatibilities arising from future changes to them. The product information on the Web Site or Materials is
subject to change without notice. Do not finalize a design with this information.

Enviromental Policies

The producer of Arduino' | has joined the Impatto Zero®
policy of LifeGate.it. For each Arduino board produced is
created / looked after half squared Km of Costa Rica’s
forest’s.
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" TCS3200, TCS3210
[AOS .. PROGRANMASLE
L
soLuTIONS® COLOR LIGHT-TO-FREQUENCY CONVERTER
TAOS099 — JULY 2009
® High-Resolution Conversion of Light PACKAGE D
Intensity to Frequency 8-LEAD SOIC
(TOP VIEW)
® Programmable Color and Full-Scale Output
Frequency so 1 1] [ 8 s3
® Communicates Directly With a Microcontroller
. x S12 1 —1 7 s2
® Single-Supply Operation (2.7 V t0 5.5 V)
® Power Down Feature OE 3 [1 1 6 OUT
® ¢ 2 . 5
Nonlinearity Error Typically 0.2% at 50 kHz GND 4 \[“/ & 1 5 Vpp
® Stable 200 ppm/°C Temperature Coefficient
® Low-Profile Lead (Pb) Free and RoHS T8a200
Compliant Surface-Mount Package
so 1 I G 1 8 8S3
Description 812 [ m — 7 s2
The TCS3200 and TCS3210 programmgble colqr OF 3 [T ™1 & OUT
light-to-frequency converters that combine confi-
gurable silicon photodiodes and a current-to-fre- GND 4 [ \Is/ r’l— T 5 Vpp

quency converter on a single monolithic CMOS
integrated circuit. The output is a square wave
(50% duty cycle) with frequency directly propor-
tional to light intensity (irradiance).

TCS3210

The full-scale output frequency can be scaled by one of three preset values via two control input pins. Digital
inputs and digital output allow direct interface to a microcontroller or other logic circuitry. Output enable (OE)
places the output in the high-impedance state for multiple-unit sharing of a microcontroller input line.

In the TCS3200, the light-to-frequency converter reads an 8 x 8 array of photodiodes. Sixteen photodiodes have
blue filters, 16 photodiodes have green filters, 16 photodiodes have red filters, and 16 photodiodes are clear
with no filters.

In the TCS3210, the light-to-frequency converter reads a 4 x 6 array of photodiodes. Six photodiodes have blue
filters, 6 photodiodes have green filters, 6 photodiodes have red filters, and 6 photodiodes are clear with no
filters.

The four types (colors) of photodiodes are interdigitated to minimize the effect of non-uniformity of incident
irradiance. All photodiodes of the same color are connected in parallel. Pins S2 and S3 are used to select which
group of photodiodes (red, green, blue, clear) are active. Photodiodes are 110 um x 110 um in size and are on
134-um centers.

Functional Block Diagram

g e e W R N T T — g
| r7Agign
| [
—> hat odiss Current-to-Frequency
1 Ll

Light : Array Converter |
| |
L___T_’_ ________ j_“‘____l

S2 S3 S0 Si1 OE
The LUMENOLOGY © Company Copyright © 2009, TAOS Inc.

Texas Advanced Optoelectronic Solutions Inc.
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Terminal Functions

TERMINAL
NAME NoO. Vo DESCRIPTION

GND 4 Power supply ground. All voltages are referenced to GND.

OE 3 | Enable for f, (active low).

ouT 6 (0] Qutput frequency (fo).

S0, S1 2 | Qutput frequency scaling selection inputs.

S2, S3 7,8 | Photodiode type selection inputs.

Vbp 5 Supply voltage

Table 1. Selectable Options

S0 S1 OUTPUT FREQUENCY SCALING (fo) S2 S3 PHOTODIODE TYPE
£ L Power down L L Red
L H [2% L H Blue
H L 20% H L Clear (no filter)
H H 100% H H Green

Available Options

DEVICE Ta PACKAGE - LEADS | PACKAGE DESIGNATOR | ORDERING NUMBER
TCS3200 —-40°C to 85°C SOIC-8 D TCS3200D
TCS3210 —-40°C to 85°C SOIC-8 D TCS3210D

Copyright © 2009, TAOS Inc.

TAOS
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Absolute Maximum Ratings over operating free-air temperature range (unless otherwise noted)t

Supply:voltage; Vi (seeiNote 1) «...vouwmmess aemurosmmommmass somams o comsms s ¢ 6V
Input:voltage range; all iNPUtS; VI  usuummsmmmen ssmsmmmsemmien s 4me 48 em e < -0.3VtoVpp+0.3V
Operating free-air temperature range, Ta(see Note 2) ....... ... ... ... .ot —40°C to 85°C
Storage temperature range (seeNote2) .......... ... i —40°C to 85°C
Solder conditions in accordance with JEDEC J-STD-020A, maximum temperature (see Note 3) ... 260°C

1 Stresses beyond those listed under “absolute maximum ratings” may cause permanent damage to the device. These are stress ratings only, and
functional operation of the device at these or any other conditions beyond those indicated under “recommended operating conditions” is not
implied. Exposure to absolute-maximum-rated conditions for extended periods may affect device reliability.

NOTES: 1. Allvoltage values are with respect to GND.

2. Long-term storage or operation above 70°C could cause package yellowing that will lower the sensitivity to wavelengths < 500nm.
3. The device may be hand soldered provided that heat is applied only to the solder pad and no contact is made between the tip of
the solder iron and the device lead. The maximum time heat should be applied to the device is 5 seconds.

Recommended Operating Conditions

MIN NOM MAX | UNIT
Supply voltage, Vpp 27 5 55 \
High-level input voltage, Vi Vpp=27Vto55V 2 Voo Vv
Low-level input voltage, V. Vpp=27Vto55V 0 0.8 \
Operating free-air temperature range, Ta -40 70 °C

Electrical Characteristics at Ty = 25°C, Vpp = 5 V (unless otherwise noted)

PARAMETER TEST CONDITIONS MIN TYP MAX| UNIT
Vou High-level output voltage loy=-2mA 4 45 Vv
VoL Low-level output voltage loL=2 mA 025 0.40 \
i High-level input current 5 uHA
I Low-level input current 5 HA
Power-on mode 1.4 2 mA
oo Supplyjerent Power-down mode 0.1 A
S0=H,S1=H 500 600 kHz
Full-scale frequency (See Note 4) S0=H,S1=L 100 120 kHz
So=L,S1=H 10 12 kHz
Temperature coefficient of responsivity A<700nm,-25°C < Ty < 70°C +200 ppm/°C
ksvs Supply voltage sensitivity Vpp =5V +£10% +0.5 %IV

NOTE 4: Full-scale frequency is the maximum operating frequency of the device without saturation.

The LUMENOLOGY © Company
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Operating Characteristics at Vpp = 5 V, Tp = 25°C, SO = H, S1 = H (unless otherwise noted)
(See Notes 5, 6, 7, and 8). Values for TCS3200 (TCS3210) are below.

CLEAR BLUE GREEN RED
TEST PHOTODIODE PHOTODIODE PHOTODIODE PHOTODIODE
PARAMETER | ~oNDITIONS S2=H,S3=L S2=L,83=H S2=H,S3=H s2=1,83=L | UNIT
MIN TYP MAX|MIN TYP MAX|MN TYP MAX| MIN TYP MAX
Eo=472uWicm?, | 125 156 187
% % % % % o
A= 470 m w60l 84% | 229 43% | 09 6%
Output 125 156 187
Ee =40.4 pW/icm?2 - : :
fo frequency S g 8% 28% | 57% 80% | 9% 27% | kHz
(Noteg) | p=524nm (47) (585  (7)
Eo=346uWiem2, | 131 164 197[ i , .
lp ~ 640 nm @9) (615 (7.4) 5% 21% | 0% 12% | 84% 105%
l 331 oy 0/ 0, 0 O/
p=470 nm (122) 61% 84% | 22% 43% | 0% 6%
Irradiance 386 Hz/
Re responsivity | A, =524 nm 8% 28% | 57% 80% | 9% 27% | (WW/
(Note 10) (145) cm2)
} 474 0y oy 0y 0y
\p = 640 nm (178) 5% 21% | 0% 12% | 84% 105%
— 1813
p =470 nm (4839) - —_ -_
Saturation 1554
iradiance | A, =524 nm 5 — — — ng/
(Note 11) (4138)
N 1266
p =640 nm @371) — — —
fo Park Ee=0 2 10 2, 10 2 10 2 10| Hz
requency
fo=0to 5 kHz +0.1 +0.1 +0.1 +0.1
Nonlinearity LY "
(N fo= 0 to 50 kHz + +0.2 +0.2 +0.2 % FS.
fo=0to 500 kHz + as + i
Recovery
from power 100 100 100 100 us
down
Response
limegto otz 100 100 100 100 ns
put enable
(GE)
NOTES: 5. Optical measurements are made using small-angle incident radiation from a light-emitting diode (LED) optical source.

6. The 470 nm input irradiance is supplied by an InGaN light-emitting diode with the following characteristics:
peak wavelength A, = 470 nm, spectral halfwidth ALYz =35 nm, and luminous efficacy = 75 Im/W.

7. The 524 nm input irradiance is supplied by an InGaN light-emitting diode with the following characteristics:
peak wavelength Ap = 524 nm, spectral halfwidth ALY = 47 nm, and luminous efficacy = 520 Im/W.

8. The 640 nm input irradiance is supplied by a AlInGaP light-emitting diode with the following characteristics:
peak wavelength A, = 640 nm, spectral halfwidth ALY =17 nm, and luminous efficacy = 155 Im/W.

9. Output frequency Blue, Green, Red percentage represents the ratio of the respective color to the Clear channel absolute value.
10. lrradiance responsivity Rg is characterized over the range from zero to 5 kHz.

11. Saturation irradiance = (full-scale frequency)/(irradiance responsivity) for the Clear reference channel.

12. Nonlinearity is defined as the deviation of f from a straight line between zero and full scale, expressed as a percent of full scale.

Copyright © 2009, TAOS Inc.
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TYPICAL CHARACTERISTICS

PHOTODIODE SPECTRAL RESPONSIVITY
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Figure 1
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Figure 3
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TYPICAL CHARACTERISTICS

PHOTODIODE RESPONSIVITY TEMPERATURE COEFFICIENT
vs.
WAVELENGTH OF INCIDENT LIGHT
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Figure 5
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APPLICATION INFORMATION

Power supply considerations

Power-supply lines must be decoupled by a 0.01-uF to 0.1-uF capacitor with short leads mounted close to the
device package.

Input interface

A low-impedance electrical connection between the device OE pin and the device GND pin is required for
improved noise immunity. All input pins must be either driven by a logic signal or connected to VDD or GND —
they should not be left unconnected (floating).

Output interface

The output of the device is designed to drive a standard TTL or CMOS logic input over short distances. If lines
greater than 12 inches are used on the output, a buffer or line driver is recommended.

A high state on Output Enable (OE) places the output in a high-impedance state for multiple-unit sharing of a
microcontroller input line.

Power down

Powering down the sensor using S0/S1 (L/L) will cause the output to be held in a high-impedance state. This
is similar to the behavior of the output enable pin, however powering down the sensor saves significantly more
power than disabling the sensor with the output enable pin.

Photodiode type (color) selection

The type of photodiode (blue, green, red, or clear) used by the device is controlled by two logic inputs, S2 and
S3 (see Table 1).

Output frequency scaling

Output-frequency scaling is controlled by two logic inputs, SO and S1. The internal light-to-frequency converter
generates a fixed-pulsewidth pulse train. Scaling is accomplished by internally connecting the pulse-train output
of the converter to a series of frequency dividers. Divided outputs are 50%-duty cycle square waves with relative
frequency values of 100%, 20%, and 2%. Because division of the output frequency is accomplished by counting
pulses of the principal intemal frequency, the final-output period represents an average of the multiple periods
of the principle frequency.

The output-scaling counter registers are cleared upon the next pulse of the principal frequency after any
transition of the SO, S1, S2, S3, and OE lines. The output goes high upon the next subsequent pulse of the
principal frequency, beginning a new valid period. This minimizes the time delay between a change on the input
lines and the resulting new output period. The response time to an input programming change or to an irradiance
step change is one period of new frequency plus 1 us. The scaled output changes both the full-scale frequency
and the dark frequency by the selected scale factor.

The frequency-scaling function allows the output range to be optimized for a variety of measurement
techniques. The scaled-down outputs may be used where only a slower frequency counter is available, such
as low-cost microcontroller, or where period measurement techniques are used.

The LUMENOLOGY © Company Copyright © 2009, TAOS Inc.

TEXAS
ADVANCED
OPTOELECTRONIC

OTAOS .

www.taosinc.com 7




79

TCS3200, TCS3210
PROGRAMMABLE
COLOR LIGHT-TO-FREQUENCY CONVERTER

TAOS099 — JULY 2009

APPLICATION INFORMATION

Measuring the frequency

The choice of interface and measurement technique depends on the desired resolution and data acquisition
rate. For maximum data-acquisition rate, period-measurement techniques are used.

Output data can be collected at a rate of twice the output frequency or one data point every microsecond for
full-scale output. Period measurement requires the use of a fast reference clock with available resolution directly
related to reference clock rate. Output scaling can be used to increase the resolution for a given clock rate or
to maximize resolution as the light input changes. Period measurement is used to measure rapidly varying light
levels or to make a very fast measurement of a constant light source.

Maximum resolution and accuracy may be obtained using frequency-measurement, pulse-accumulation, or
integration techniques. Frequency measurements provide the added benefit of averaging out random- or
high-frequency variations (jitter) resulting from noise in the light signal. Resolution is limited mainly by available
counter registers and allowable measurement time. Frequency measurement is well suited for slowly varying
or constant light levels and for reading average light levels over short periods of time. Integration (the
accumulation of pulses over a very long period of time) can be used to measure exposure, the amount of light
present in an area over a given time period.

PCB Pad Layout
Suggested PCB pad layout guidelines for the D package are shown in Figure 6.

=il r

4,*
L]
e
3]
1
I«

NOTES: A. Alllinear dimensions are in millimeters.
B. This drawing is subject to change without notice.

Figure 6. Suggested D Package PCB Layout
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MECHANICAL INFORMATION

This SOIC package consists of an integrated circuit mounted on a lead frame and encapsulated with an electrically
nonconductive clear plastic compound. The TCS3200 has an 8 X 8 array of photodiodes with a total size of 1 mm
by 1 mm. The photodiodes are 110 um X 110 um in size and are positioned on 134 um centers.

PACKAGE D
NOTES TOP VIEW
2.12 ‘H 3.00 = 0.250 *»|
+ 0.250
=P =
PIN 1 '
i\
? — | =] =] od I I
6 x1.27 l_' _] J
=] \ phuAS 2o
x &
228TYP
CLEAR WINDOW
END VIEW
ool 0.88 TYP TOP OF
0.25 _” "/‘yT SENSOR DIE
( A

H

4.00

~
L

3.80

»
»

< 6.20 >

5.80

D)

NOTES: A. All linear dimensions are in millimeters.

ooOw

PLASTIC SMALL-OUTLINE

BOTTOM VIEW

|
o

IRl

—

EI[

PIN 1 :[2]

il -

127
041

— 4 o025

SIDE VIEW
e 5.00 "
|‘ 4.80 14
” 5.3 e
% MAX .4
DETAIL A
025
0.19
A
v v

0.10

The center of the 1-mm by 1-mm photo-active area is referenced to the upper left corner tip of the lead frame (Pin 1).
. Package is molded with an electrically nonconductive clear plastic compound having an index of refraction of 1.55.
. This drawing is subject to change without notice.

Figure 7. Package D — TCS3200 Plastic Small Outline IC Packaging Configuration
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MECHANICAL INFORMATION

This SOIC package consists of an integrated circuit mounted on a lead frame and encapsulated with an electrically
nonconductive clear plastic compound. The TCS3210 has a 4 X 6 array of photodiodes with a total size of 0.54 mm
by 0.8 mm. The photodiodes are 110 um X 110 um in size and are positioned on 134 um centers.

PACKAGE D PLASTIC SMALL-OUTLINE
HOTER TOP VIEW BOTTOM VIEW
2. 12\ ‘H 3.00 + 0.250 *»|

+ 0.250

LT LL‘_,_

- |

Fg { LA =] ==

l—+-—| "o s N T = | =

_____ %‘% )31 P|N1l:[£| &]:I
T e i — e

| I \ H_‘ I ]J: V- SIDE VIEW

\_ @28 TYP

CLEAR WINDOW LU(
55X
|

v _V_\.&[_J

5.00
END VIEW 24
53
0.50 Y
50 e 0.88 TYP TOP OF
0:25 ’ ‘ /';W SENSOR DIE
- 7 3
1.75 717
1.35
i E—Jf \ \ I DETAIL A
e 4.00 J
I 3.80 g
6.20
< 5.80 ’ 025
0.19
1 A
® e
1.27 t
0.25
0.41 | 0.10

NOTES: A. Alllinear dimensions are in millimeters.

The center of the 0.54-mm by 0.8-mm photo-active area is referenced to the upper left corner tip of the lead frame (Pin 1).
Package is molded with an electrically nonconductive clear plastic compound having an index of refraction of 1.55.

This drawing is subject to change without notice.
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Figure 8. Package D — TCS3210 Plastic Small Outline IC Packaging Configuration
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MECHANICAL INFORMATION

SIDE VIEW
Ko 2.1+ 0.10 [0.083 = 0.004]
0.292 + 0.013

| |/ \ | | | \ r[o.ons:o.om]
—t

TOP VIEW END VIEW
- 8+0.1 4:01 2005
1 < [0315+ —p <«—»[0157 =+ [0.079 + 4> 1.75 + 0.10
0.004] 0.004] 0.002] r [0.069 = 0.004]
v T
[~*8 550 + 0.05
e [0.217 = 0.002]
V= v
O > (> O 12403-01
[0.472 + 0.12 - 0.004]
A A ¥B
DETAIL A DETAIL B

1 6.45 + 0.10 ’ 5.13 + 0.10
1 3 0.254 = 0.004 | > [0.202 = 0.004
A [ 1 B [ ]

o

NOTES: A. All inear dimensions are in millimeters [inches].

B. The dimensions on this drawing are for illustrative purposes only. Dimensions of an actual carrier may vary slightly.
C. Symbols on drawing Ao, Bo, and K are defined in ANSI EIA Standard 481-B 2001.

D. Each reelis 178 millimeters in diameter and contains 1000 parts.

E. TAOS packaging tape and reel conform to the requirements of EIA Standard 481-B.

F

. This drawing is subject to change without notice.

Figure 9. Package D Carrier Tape
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MANUFACTURING INFORMATION

The Plastic Small Outline IC package (D) has been tested and has demonstrated an ability to be reflow soldered

to a PCB substrate.

The solder reflow profile describes the expected maximum heat exposure of components during the solder
reflow process of product on a PCB. Temperature is measured on top of component. The component should
be limited to a maximum of three passes through this solder reflow profile.

Table 2. TCS3200, TCS3210 Solder Reflow Profile

PARAMETER REFERENCE TCS32x0
Average temperature gradient in preheating 2.5°C/sec
Soak time tsoak 2 to 3 minutes
Time above 217°C t Max 60 sec
Time above 230°C to Max 50 sec
Time above Tpeay ~10°C t3 Max 10 sec
Peak temperature in reflow Tpeak 260° C (-0°C/+5°C)
Temperature gradient in cooling Max -5°C/sec

Not to scale — for reference only

Tpeak

T3

T2

Ty

Temperature (°C)

Time (sec)
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Figure 10. TCS3200, TCS3210 Solder Reflow Profile Graph
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Moisture Sensitivity

Optical characteristics of the device can be adversely affected during the soldering process by the release and
vaporization of moisture that has been previously absorbed into the package molding compound. To prevent
these adverse conditions, all devices shipped in carrier tape have been pre-baked and shipped in a sealed
moisture-barrier bag. No further action is necessary if these devices are processed through solder reflow within
24 hours of the seal being broken on the moisture-barrier bag.

However, for all devices shipped in tubes or if the seal on the moisture barrier bag has been broken for 24 hours
or longer, it is recommended that the following procedures be used to ensure the package molding compound
contains the smallest amount of absorbed moisture possible.

For devices shipped in tubes:
1. Remove devices from tubes
2. Bake devices for 4 hours, at 90°C
3. After cooling, load devices back into tubes
4. Perform solder reflow within 24 hours after bake

Bake only a quantity of devices that can be processed through solder reflow in 24 hours. Devices can be
re-baked for 4 hours, at 90°C for a cumulative total of 12 hours (3 bakes for 4 hours at 90°C).

For devices shipped in carrier tape:
1. Bake devices for 4 hours, at 90°C in the tape
2. Perform solder reflow within 24 hours after bake

Bake only a quantity of devices that can be processed through solder reflow in 24 hours. Devices can be
re-baked for 4 hours in tape, at 90°C for a cumulative total of 12 hours (3 bakes for 4 hours at 90°C).
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PRODUCTION DATA — information in this document is current at publication date. Products conform to
specifications in accordance with the terms of Texas Advanced Optoelectronic Solutions, Inc. standard
warranty. Production processing does not necessarily include testing of all parameters.

LEAD-FREE (Pb-FREE) and GREEN STATEMENT

Pb-Free (RoHS) TAOS' terms Lead-Free or Pb-Free mean semiconductor products that are compatible with the current
RoHS requirements for all 6 substances, including the requirement that lead not exceed 0.1% by weight in homogeneous
materials. Where designed to be soldered at high temperatures, TAOS Pb-Free products are suitable for use in specified
lead-free processes.

Green (RoHS & no Sb/Br) TAOS defines Green to mean Pb-Free (RoHS compatible), and free of Bromine (Br) and
Antimony (Sb) based flame retardants (Br or Sb do not exceed 0.1% by weight in homogeneous material).

Important Information and Disclaimer The information provided in this statement represents TAOS’ knowledge and
belief as of the date that it is provided. TAOS bases its knowledge and belief on information provided by third parties,
and makes no representation or warranty as to the accuracy of such information. Efforts are underway to better integrate
information from third parties. TAOS has taken and continues to take reasonable steps to provide representative
and accurate information but may not have conducted destructive testing or chemical analysis on incoming materials and
chemicals. TAOS and TAOS suppliers consider certain information to be proprietary, and thus CAS numbers and other
limited information may not be available for release.

NOTICE

Texas Advanced Optoelectronic Solutions, Inc. (TAOS) reserves the right to make changes to the products contained in this
document to improve performance or for any other purpose, or to discontinue them without notice. Customers are advised
to contact TAOS to obtain the latest product information before placing orders or designing TAOS products into systems.

TAOS assumes no responsibility for the use of any products or circuits described in this document or customer product
design, conveys no license, either expressed or implied, under any patent or other right, and makes no representation that
the circuits are free of patent infringement. TAOS further makes no claim as to the suitability of its products for any particular
purpose, nor does TAOS assume any liability arising out of the use of any product or circuit, and specifically disclaims any
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Water Pressure Sensor G1/4 1.2Mpa

SKU 114991178

Description

This is a pressure measuring sensor. You can use it in clean, non-corrosive gas and liquid.
Features

Compact, Easy to Install

High Sealing Performance

High Quality Hall Effect Sensor

RoHS Compliant
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Specifications

Wokring Voltage: DC 5+0.5V
Working Current: <10mA (DC 5V)
Working Voltage: DC 0.5~4.5V
Working Pressure Rate Range: 0~1.2Mpa
Max. Pressure: 2.4Mpa

Destructive pressure: 3.0Mpa
Working Temperature: -20~+ 105°C
Storage Temperature: -20~+ 105°C
Measurement Accuracy: +1.5%FS
Responsc Time: <2.0ms

IP65

Cycle Life: 1,000,000 pcs
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Partlist

1 x Water Pressure Sensor

Technical Details
Weight G.W 52¢g
Battery Exclude
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SONGLE RELAY

— B

m— R) SONGLE RELAY

RELAY [1S09002

SRD

2. APPLICATIONS

1. MAIN FEATURES

O Switching capacity available by 10A in spite of
small size design for highdensity P.C. board

mounting technique.

O UL,CUL,TUV recognized.

[0 Selection of plastic material for high temperature and

better chemical solution performance.

[ Sealed types
available.

[ Simple relay magnetic circuit to meet low cost of

mass production.

[0 Domestic appliance, office machine, audio, equipment, automobile, etc.

( Remote control TV receiver, monitor display, audio equipment high rushing current use application.)

3. ORDERING INFORMATION

SRD XX VDC s L @
Madel of relay Nominal coil voltace Structure (01l Contact fonm
S:Sealed L:0.36W ‘
SRD 03050699124 U8VDC T ITHERNT
F-Flux free tune N-0 45\ C1 form C
4. RATING
cce FILE NUMBER:CQC03001003729 7A/240VDC
ceé FILE NUMBER:CQC03001003731 10A/250VDC
UL /CUL FILE NUMBER: E167996 10A/125VAC 28VDC
TUV FILE NUMBER: R50056114 10A/250VAC 30VDC
5. DIMENSIONunit:mm) DRILLINGynit:mm) WIRING DIAGRAM
19 lroa 155mnx
4
p

l2-1.04 M H_u ”

122005
;
&
?
1
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6. COIL DATA CHART (AT20° C)

Coil Coil  [Nominal [ Nominal Caoll Power Pull-In | Drop-Out [Max-Allowable!
Sensitivity Voltage |Voltage | Current |Resistance|Consumption| Voltage | Voltage Voltage
Code | (VDC) mA) (@) O (VDC) (VDC) (VDC)
U7
SRD 03 03 120 25 abt. 0.36W |75%Max. [10% Min. 120%
(High 05 05 TT& 70
ISensitivity) 06 06 60 100
09 09 40 225
12 12 30 400
24 24 5 1600
48 48 5 6400
SRN n3 n3 150 20 Aht 0 45N ] OT0 VIa | 070 I TTo
(Standard) 05 05 89.3 85
06 06 5 80
09 09 50 180 [
12 12 37.5 320 |
24 24 1R 7 1280 .
78 18 1Y 4500 AL US5TW
7. CONTACT RATING 9.REFERENCE DATA
Type SRD Coil Temperature Rise
EORM C EQRMA 3
A ~
joni=ct G 2 30VDC ERL A g s
NESISTvVE COau \LUbLl = l) 10A 125VAC TURZHUVACT é 3':1‘)
Inductive Load 10A 5A 120VAC E -
cosl =0.4 L/R=7msec) 250VAC 5A 28VDC g T
3A 120VAC g' A
3A 28VDC =
2Z50VAT/TIOVDC — [250VAT/TIOVDT
z BUOVATT2Z0WW T200VA7300W %o g 92 03 or o5 oo
[Contacm' |_Agcdo AgCdO | Operation Time
f b ||n> T
Tun 10} ettt L
Wl i SRD  pext tion tim| e
(Contact-Resistance 480mE—Mean
Operation Time 10msec Max. 7 ‘ ]
Release Time Smsec Max. 2 Relessle e
Dieteetrie-Strength i Y
i H S e e o
Between contacts 1000VAC 50/60HZ (1 minute) ,‘53 Power (W)
Insulation Resistance 100 Ml Min. (500VDC) Af:f,\fffic\t?fcyl
Max—ONOF—Switching
Mechanically 300 n'niara_ﬁnn/min
[Electrically 30 operation/min i
Ambient Temperature -251C to +70 C 2 N
Operating Humidity 45 to 85% RH % p
\ibration % 4
Endurance 10 to 55Hz Double Amplitude 1.5mm é
Error Operation 10 to 55Hz Double Amplitude 1.5mm & 4
IShock Current of Load (A)
Endurance 100G Min. Life Expectancy
Error Operation 10G Min. e
lLife Expectancy E
IMechanically 10" operations Min (na laad) w b
Electrically 10° operations. Min. (at rated coil voltage) & 9 Ac:lisovratis
Weight abt. 10grs. g
2 5
g ;
& % T f s & 7

[S)

4 8
Current of Load (A)
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